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FAILURE OR IMPROPER SELECTION OR IMPROPER USE OF THE PRODUCTS DE-
SCRIBED HEREIN OR RELATED ITEMS CAN CAUSE DEATH, PERSONAL INJURY AND 

PROPERTY DAMAGE.

This document and other information from Parker-Hannifin Corporation, its subsidiaries and 
authorized distributors provide product or system options for further investigation by users 

having technical expertise.

The user, through its own analysis and testing, is solely responsible for making the final selection 
of the system and components and assuring that all performance, endurance, maintenance, 

safety and warning requirements of the application are met. The user must analyze all aspects 
of the application, follow applicable industry standards, and follow the information concerning 

the product in the current product catalog and in any other materials provided from Parker or its 
subsidiaries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors provide component or 
system options based upon data or specifications provided by the user, the user is responsible 
for determining that such data and specifications are suitable and sufficient for all applications 

and reasonably foreseeable uses of the components or systems.

WARNING — USER RESPONSIBILITY
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A B

Y

Code
Spool position on 

power down
Code

Spool position on 
power down

A 3) H 5) 6) a 0 b

A B

P T

B 3) J 5) 6) a 0 b

A B

P T

C 4)

D*FP

Ordering code

Nominal
size

Direct. 
control 
valve

Spool-
type
(see 

catalogue)

Command-
signal

Y-port
plugged 

(resp. 
verify) 2)

Seal Design 
series

(not 
required for 

ordering)

Spool 
position 

on power 
down 1)

Code Nominal size

1 NG06 / CETOP 03

3 NG10 / CETOP 05

Code Connection

0 6 + PE

5 11 + PE

7 6 + PE + Enable

Code Signal Function

B +/- 10 V 0...+10 V -> P-A

E +/- 20 mA 0...+20 mA -> P-A

K +/- 10 V 0...+10 V -> P-B

S 4...20 mA 12...20 mA -> P-A

D F P 9 D

Freely 
config. 
super-
vising 

control 
circuit

Code Seal

N NBR

V FPM

H for HFC fluid
1)	 On power down the spool moves in a defined position.  

This cannot be guaranteed in case of single flow path on the control edge A – T resp. 
	 B – T with pressure drops above 120 bar or contamination in the hydraulic fluid.
2) 	 Needs to be removed at tank pressure >35 bar.
3) 	 Approx. 10 % opening, only zero lapped spools and underlap spools.
4) 	 Only for overlapped spools.
5) 	 D1FP: Flow for code M: 35 l/min at ∆p 35 bar.
6) 	 Only D1FP

1.	 Introduction

Elec-
tronics 
option
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Characteristics of valve driver 

The integral electronic driver combines all func-
tions for optimal operation of the valve. Thanks 
to its excellent dynamic the valve is deployable 
within closed loop control applications. The most 
important features are: 

•	 freely configurable supervising control circuit
•	 high dynamic actuator with specially designed 

electronic driver 
•	 closed loop controlled spool position 
•	 constant current actuator control with overcur-

rent shutoff 
•	 excellent properties for response sensitivity and 

temperature drift 
•	 differential input stage with various command 

signal options 
•	 diagnostic output for spool stroke / overcurrent 

state 
•	 meets relevant European EMC-standards

Name plate Block diagram of onboard electronics

Code 0 (6+PE)

Code 5 (11+PE)

Code 7 (6+PE with enable)

hydr. spool symbol
order code
nominal pressure

1) Do not connect with supply voltage zero.
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Technical data

General
Model Proportional directional control valve
Drive VCD®-actuator
Mounting interface NG06 (CETOP 03) / NG10 (CETOP 05)
Installation position unrestricted
Sensitivity [%] < 0.03
Hysteresis [%] < 0.05
Temp. drift of center postion [%/K] < 0.025
Ambient temperature [°C] -20...+50
Vibration resistance [G] 10 Sinus 5...2000 Hz acc. IEC 68-2-6

10 (RMS) Random noise 20...2000 Hz acc. IEC 68-2-36
15 Shock acc. IEC 68-2-27

Weight [kg] NG06: 3.6 / NG10: 6.5
Hydraulic
Fluid Hydraulic oil according to DIN 51524 ... 535, other on request
Fluid temperature [°C] Seal code: N: -25...+60, H, V: -20...+60
Viscosity permitted	 [cSt]/
	 recommended 	 [cSt]/

[mm2/s]
[mm2/s]

20...400
30...80

Filtration ISO 4406; 18/16/13
Operating pressure max. [bar] 350 for ports P, A, B / max. 35 for port T at internal drain, 

350 when using port Y / port Y max. 35 1)

Electrical
Duty ratio [%] 100
Protection class IP65 in accordance with EN 60529 (with correctly mounted plug-in connec-

tor)
Supply voltage / ripple [V] 22...30, electric shut-off < 19, ripple < 5 % eff., surge free
Current consumption max. [A] 3.5
Pre-fusing [A] 4.0 A medium lag
Input signal 	Code B, (K)	voltage
			   Impedance

[V]
[kOhm]

+10...0...-10, ripple < 0.01 % eff., surge free, 0...+10 V P–>A (P–>B)
100

  		  Code E 	 current
			   Impedance

[mA]
[Ohm]

+20...0...-20, ripple < 0.01 % eff., surge free, 0...+20 mA P–>A
<250

	   	 Code S	 current
			   Impedance

[mA]
[Ohm]

4...12...20, ripple < 0.01 % eff., surge free, 12...20 mA P–>A
<250
< 3.6 mA = enable off, > 3.8 mA = enable on acc. NAMUR NE43

Input capacitance typ. [nF] 1
Differential input voltage max.
		  Code 0
		  Code 5

		  Code 7

[V]

[V]

[V]

30 for terminal D and E against PE (terminal G)
11 for terminal D and E against 0 V (terminal B)
30 for terminal 4 and 5 against PE (terminal W )
11 for terminal 4 and 5 against 0 V (terminal 2)
30 for terminal D and E against PE (terminal G)
11 for terminal D and E against 0 V (terminal B)

Enable signal	 Code 5/7 [V] 5...30, Ri = > 8 kOhm
Diagnostic signal            [V] +10...0...-10 / +12.5 error detection, rated max. 5 mA
EMC EN 61000-6-2, EN 61000-6-4
Electrical connection
		  Code 0/7
		  Code 5

6 + PE acc. EN 175201-804
11 + PE acc. EN 175201-804

Wiring min. 	 Code 0/7
		  Code 5

[mm²]
[mm²]

7 x 1.0 (AWG16) overall braid shield
8 x 1.0 (AWG16) overall braid shield

Wiring length max. [m] 50

1) For applications with pT>35 bar (max 350 bar) the Y-port has to be connected and the plug in the Y-port has to 
be removed.
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2.	 Safety instructions

Please read the operation manual before installa-
tion, start-up, service, repair or stocking! Disregard 
may result in damaging the valve or incorporated 
system parts.
				  
Symbols

This manual uses symbols which have to be fol-
lowed accordingly:
					      

	 Instructions with regard to the warranty
				     
	 Instructions with regard to possible dam-
aging of the valve or linked system com-
ponents

	  
	 Helpful additional instructions
				     

Service

Workings in the area of installation, commissioning, 
maintenance and repair of the valve may only be 
allowed by qualified personnel. These are persons 
which have, because of education, experience 
and instruction, sufficient knowledge on relevant 
directives and approved technical rules.

3.	 Important details

Intended usage

This operation manual is valid for proportional 
directional control valves DFplus series. Any dif-
ferent or unintended usage is to be considered as 
not intended. The manufacturer is not liable for 
warranty claims resulting from this.

Common instructions

Parker reserves the right for technical modifications 
of the described product. Illustrations and drawings 
within this manual are simplified representations. 
Due to improvement or modification of the product 
the illustrations might not match precisely with 
the described valve. The technical specifications 
and dimensions are not binding. No claims can be 
derived of it. Copyrights are reserved.

Liability		   

Parker does not assume liability for damage due 
to the following failures:

•	 incorrect mounting / installation	
•	 improper handling		   
•	 lack of maintenance		   
•	 unintended usage
		

Do not disassemble the valve! In case of 
suspicion for a defect please contact Parker.

Storage		   

In case of temporary storage the valve must be 
protected against contamination, atmospheric 
exposure and mechanical damages. Each valve has 
been factory tested with hydraulic oil, resulting in 
protection of the internal parts against corrosion. 
Yet this protection is only ensured under the fol-
lowing conditions:			    

	Outdoor storage or within sea and tropical 
climate will lead to corrosion and might dis-
able the valve!

4.	 Mounting / Installation

Scope of supply

Please check immediately after receiving the valve, 
if the content is matching with the specified scope 
of supply. The delivery includes:

•	 valve
•	 operation manual
The central connector has to be ordered separately 
and is not included in the delivery.

	 Please check the delivery immediately after 
receiving the shipment for apparent dam-
ages due to shipping. Report shipment 
losses at once to the carrier and the sup-
plier!

Storage 
period

Storage requirements

12 months
constant humidity < 60 % as well 
as constant temperature < 25 °C 

6 months
varying humidity as well as 		
varying temperature < 35 °C
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Mounting	

•	 Compare valve type (located on the name plate) 
with bill of materials respectively circuit diagram.

•	 The valve may be mounted fix or movable in 
any direction.

•	 Check mounting surface for the valve. Uneve-
ness of 0.01 mm/100 mm, surface finish of 6.3 
µm are tolerable values.

	 Keep valve mounting surface and work en-
vironment clean!			 

•	 Remove protection plate from the valve moun-
ting surface	

•	 Check the proper position of the valve ports 
and the O-rings.

•	 Mounting bolts: 
	 D1FP: 4 pcs. M5x30
	 D3FP: 4 pcs. M6x40 
	 use property class ISO 4762-12.9

•	 	Bolt kits:
	 D1FP: BK375 
	 D3FP: BK385

•	 Tighten the bolts crisscross with the following 
torque values:

	 D1FP: 7.6 Nm 
	 D3FP: 13.2 Nm

	 Insufficient condition of the valve mounting 
surface might create malfunction!	

	 Incorrect mounting resp. bolt torque may 
result in abrupt leakage of pressure fluid on 
the valve ports.

Limits of use

The valve may be operated within the determined 
limits only. Please refer to the “technical data“ 
section as well as to the “characteristic curves“ 
in the Parker catalogue HY11-3500/UK “Hydraulic 
Valves Industrial Standard”.			 

	Follow the environmental conditions! Unal-
lowable temperatures, shock load, aggresive 
chemicals exposure, radiation exposure, il-
legal electromagnetic emissions may result 
in operating trouble and may lead to failure! 
Follow the operating limits listed in the cata-
logue HY11-3500/UK “Hydraulic Valves In-
dustrial Standard“, see technical data.

Pressure fluids

The following rules applies for the operation with 
various pressure fluids:

	This above information serves for orientation 
and does not substitute user tests among 
the particular operating conditions. In par-
ticular, no liability for media compatibility may 
be derived out of it.

Mineral oil: usable without restriction.
HFC: choose the right seal option.

For operation with the following pressure fluids 
please consult Parker:

	For detailed information concerning pressure 
fluids note VDMA-document 24317 as well 
as DIN 51524 & 51502.

Electrical connection

The valve is connected electrically by one common 
cable and a central connector.				  
	
The connection codes 0 and 7 require a 6 + PE 
female connector EN 175201-804.

HFA oil-in-water emulsion
HFB water-in-oil emulsion
HFD unhydrous fluids (Phosphor-Ester)

	The female connector can be ordered sepa-
rately under article nr. 5004072.			 
	
In case third party connectors are used, ac-
cordance to the relevant EMC directives must 
be ensured.		
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The connecting cable has to comply to the follow-
ing specification:

Cable type	 control cable, flexible, 
		  7 conductors, overall braid 	
			   shield			 
Cross section	 min. AWG16
Outer dimension	 8...12 mm
Cable length	 max. 50 m

	For cable lengths > 50 m consult Parker.

The connection cable is coupled to the female 
connector by solder joints.
The shielding has to be assembled according the 
outline below.
Skinning lengths for the connecting cable:

The connection Code 5 requires a 11 + PE female 
connector EN 175201-804.

	The female connector has to be ordered 
separately under article nr. 5004711.	

In case third party connectors are used, ac-
cordance to the relevant EMC directives must 
be ensured.
				 

The connecting cable has to comply to the follow-
ing specification:

Cable type	 control cable, flexible, 
		  8 conductors, overall braid 	
		  shield			 
Cross section	 min. AWG16
Outer dimension	 12...15 mm
Cable length	 max. 50 m

	For cable lengths > 50 m consult factory.	

The connection cable is coupled to the female 
connector by crimp contacts.
The shielding has to be assembled according the 
outline below.

Do not disconnect cable socket under volt-
age!

Skinning lengths for the connecting cable:

The backshell nut of the cable gland has to be 
tighten with a suitable tool. The target value for 
the tightening torque is 4 Nm. Tighten the cap nut 
with a torque of 5 Nm after attaching the female 
connector on the socket. 	

	 Incomplete tightening of backshell nut re-
spectively cap nut may result in undesired 
release of the connection as well as degrada-
tion of the water tightness.

	 When using female connectors of other 
manufacturers, the relevant regulations must 
be observed.				  

	The cable may only be connected to the 
female connector by authorized and qualified 
personnel. A short between individual con-
ductors resp. to the connector housing , bad 
soldering as well as improper shield connec-
tion may result in malfunction and breakdown 
of the valve.

	The mounting surface of the valve has to be 
connected to the earth grounded machine 
frame. The earth ground wire from the valve 
connecting cable as well as the cable shield 
have to be tied to the protective earth termi-
nal within the control unit. It is necessary to 
use a low ohmic potential connection be-
tween control unit and machine frame to 
prevent earth loops (cross section AWG 6).
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Enable input (only for Code 5 / 11+PE as well 
as code 7 / 6+PE)

A signal voltage enables the actuator drive of the 
valve. Continuous operation of the valve requires 
a permanent voltage 5...30 V (e.g. the supply volt-
age). In case of disabling the signal the valve will 
reach its power down position spring-actuated 
independently from the command signal value.

	The enable function represents no safety 
arrangement against unwanted valve opera-
tion in terms of accident prevention regula-
tions.

Electrical interfacing

Supply voltage 

The supply voltage for the valve has to cover the 
range of 22...30 V. Valve is de-energized below 
19 V. The residual ripple may not exceed 5 % eff.

	The applied power supply must comply to 
the relevant regulations (DIN EN 61558) and 
must carry a CE-mark. The operating voltage 
for the valve must be free of inductive 
surges. Do not exceed the max. value of 30V! 
Higher voltage can lead to failure of the valve.

	The increased inrush current of the valve 
should be considered when selecting the 
power supply. A stabilized power supply with 
overcurrent limiting feature should not be 
used. Due to the inrush current of the valve 
the current limit circuit may respond prema-
turely and create problems during energizing 
of the supply voltage.

	The operation of the valve is blocked if the 
supply voltage polarity is interchanged.

	Each valve requires a separate pre-fuse of 4 
Amp semi time-lag. Failure to observe this 
instruction may create irreparable damage 
of valve respectively incorporated system 
parts.

Wiring

Code 0, 6 + PE acc. EN 175201-804

Code 5, 11 + PE acc. EN 175201-804

Code 7, 6 + PE acc. EN 175201-804 + enable

1) Do not connect with supply voltage zero.
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Command signal input

The spool stroke is proportional to the command 
signal amplitude.

	The command input signal needs to be filtered 
as well as free of inductive surges and 
modulations. Due to the sensitivity of the 
valve a high signal quality is recommended. 
This will prevent malfunction.

	 The option 4...20 mA uses the “3.6 mA“ 
condition as breakdown-information. If the 
input signal line is interrupted, an evaluable 
failure information is available. In this case 
the actuator drive will be switched off. The 
drive will switch on when the input signal 
reaches a value of 3.8 mA, it switches off 
when the command falls below 3.6 mA. This 
determination follows the NAMUR-specifi-
cation NE43.

Diagnostic output	  

A diagnostic signal is available. Its voltage repre-
sents the operating condition of the valve. 	  

	The output may drive a load of max. 5 mA. 
Exceeding of this limit leads to malfunction.

5.	 Operating instructions

Code 
command 

signal

Command 
signal

Function
VCD 

actuator
Diagnostic 

signal

B

0…+10 V on 0…+10 V

0…-10 V on 0…-10 V

Overload     off 12.5 V

E

0…+20 mA on 0…+10 V

0…-20 mA on 0…-10 V

Overload     off 12.5 V

K

0…+10 V on 0…-10 V

0…-10 V on 0…+10 V

Overload     off 12.5 V

S

4…12 mA on 0…-10 V

12…20 mA on 0…+10 V

0…3.6 mA     off
Cable break, 

12.5 V
Overload     off 12.5 V

Code 
command 

signal

Command 
signal

Function
VCD 

actuator
Diagnostic 

signal

B

0…+10 V on 0…-10 V

0…-10 V on 0…+10 V

Overload     off 12.5 V

E

0…+20 mA on 0…-10 V

0…-20 mA on 0…+10 V

Overload     off 12.5 V

K

0…+10 V on 0…+10 V

0…-10 V on 0…-10 V

Overload     off 12.5 V

S

4…12 mA on 0…+10 V

12…20 mA on 0…-10 V

0…3.6 mA     off
Cable break, 

12.5 V

Overload     off 12.5 V

D1FP

D3FP

Pin assignment analog sensor, M12 socket

The M12 socket can be connected to voltage as 
well as current sensors.

1)	 Diagnostic signal 12,5 V in error case. Spool 
moves in a defined postion, please see order-
ing code „spool position at power down“.
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Examples position control

Current 4...12...20 mA contacts at the sensor 
input

M12 connector

I

S

Sensor

S
en

so
r 

su
pp

ly

F
ee

db
ac

k
+

Actuator

1 2

4
3

5

The earth connection is achieved via the shilding. 

	The connection of a unsuitable sensor may 
create irreparable damage of the electronics.

Voltage ±10 V (1...10 V)Wiring diagram three-wire

Wiring diagram four-wire Wiring diagram two-wire
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Spool position at power down/center position

	For valves with zero lap spools, distinction 
must be made between hydraulic neutral 
position and power-down position. Neutral 
position is taken at neutral input signal, cor-
responding to zero position of the hydraulic 
symbol. When the valve is switched off – no 
supply voltage, no enable, current signal 
(code S) < 3,8 mA – zero lap valves take the 
power down position (approximately 10 % 
opening) according to the ordering code. For 
valves with overlap spools, neutral position 
and power down position are the same (zero 
position).

Solenoid current monitoring

If the actuator current time interval exceeds 10 
seconds, the actuator is switched off to prevent 
overheating. For normal operating conditions this 
state will not reached, but it may occur with a 
contaminated sluggish valve.

	 In this case the reason for the contamination 
should be rectified (hydraulic fluid exchange, 
filtration review, valve flushing).

The overcurrent shutoff condition may be resetted 
by the actions below:

Code 0: 	 Temporary disconnection of the supply 
	 voltage.

Code 5: 	 Temporary disconnection of the enable  
	 signal.

Code 7: 	 Temporary disconnection of the enable  
	 signal.

	 The shutoff of the VCD actuator due to over-
load will be indicated via the diagnostics 
output.
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	The cover plug has to be re-installed after 
completion of the parametrizing work.

Program installation

Please check before installation if the above hard-
ware requirements are met. If your PC has already 
stored an older version of the “ProPxD” program, 
it has to be deinstalled by using the Windows® - 
system control feature.

Program installation sequence:

•	 terminate the execution of other programs
•	 execute the file “setup.exe”
•	 follow the instructions on the screen 
Answer the question, if an older version should be 
overwritten, with “ok”. During the installation you 
may change destination drive respectively instal-
lation path, if needed.

Please answer “ok” if at the end of the installation 
the program reports any system information. After 
successful installation the desktop display shows 
the ProPxD icon for starting the program.

Software operating

Brief instruction for first startup:

•	 Connect the valve electronic to the supply voltage.

•	 Connect the valve electronic to a PC via the 
parametrizing cable.

•	 Start the operating program.

•	 After displaying the program respectively data 
base version a program window opens and the 
connected valve will be automatically identified 
(possibly a manual identification via the button 
“Receive all” is necessary).

•	 Select the desired version via the menu “Op-
tions/Optionen” with the menu item “Language/
Sprache”.

Parametering interface

Parametrizing

Ordering code: 40982923

Plug for 
parametering interface

ProPxD parameterizing software

The ProPxD software permits comfortable param-
eter setting. Via the clearly arranged entry mask 
the parameters can be noticed and modified. 
Storage of complete parameter sets is possible as 
well as printout or record as a text file for further 
documentation. 

The PC software can be downloaded free of charge 
at www.parker.com/isde – see page “Support” or 
directly at www.parker.com/propxd. Please check 
periodical whether the latest version is used.

Hardware requirements	

•	 PC with operating system from Windows® XP 
upwards	

•	 Interface RS232C 	
•	 display resolution at least 800 x 600	
•	 connection cable between PC and electronic 

module	
•	 memory requirement approximately 40 MB	

	 If your PC has no serial interface according 
to RS232C standard you require in addition 
an USB-RS232C adapter.

Cable specification

	Attention! The valve electronic provides no 
USB interface, but can only be parametrized 
via an RS232C-connection. Therefore the 
usage of USB standard cables is not allowed 
and may result in damaging of valve respec-
tively PC.	
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LED flashing signals of the valve electronics
enable valve 	 OK: 	approx. 0.5 Hz (slowly, green)
disable valve 	OK: 	approx. 1 Hz (fast, green)
valve error: 		  approx. 10 Hz (very fast, green)

Error code 
(additive)

Error description

0 no errors
1 over current
2 cable break command signal
4 cable break feedback signal
8 undervoltage error
16 bus communication error
32 hardware failure

•	 The valve specific default parameters are already 
available within the parameter table.

•	 Parameter changes are possible via mouse or 
the arrow buttons on the bottom left within the 
program screen, also the parameter values may 
be edited via the keyboard.

•	 Modified parameters will be stored via the 
“Enter” key or via the button “Update list”.

•	 Parameters have to be nonvolatile stored on 
the valve via the button “save parameter”.

•	 The chosen parameters may be optionally 
stored on the PC via the “File”-menu with the 
menu item “Save as”, data retrieving is always 
possible via the function “Load file”

Extended functions:

The user software is segmented into two parameter 
ranges:	

•	 basic mode	
•	 expert mode	
For normal startup the basic mode is sufficient. 
It permits the setting of all application specific 
parameters to match the valve function with the 
task setting.	

In case of special applications the valve parameters 
may be adapted via the expert mode. The operating 
mode may be selected from the “Options”- menu 
and remains after terminating and re-start of the 
program.	

	Changing of expert parameters is only permit-
ted for qualified personnel. Incorrect settings 
may lead to malfunction! In case of parameter 
changes shut the drive down!

To prevent an unauthorized access for the expert 
mode, a password is requested. The name is 
“parker” and cannot be changed. Thus additionally 
to the button “Default” for loading of the default 
parameters, the button “Send parameter” appears 
in the “Expert”-operating mode. This button trans-
mits only the setting of one single parameter to 
the connected valve. Thus a quick tuning of single 
parameters is permitted during the setup. 	

	 A horizontal bar graph readout between 
the communication buttons shows the data 
transfer state.

	 Because the ProPxD program has also with-
out connection to the valve functionality, a 
manual pre-selection of the parameters is 
possible. After selection of the valve type via 
the menu “Options” the parameters may be 

set and stored for later transmission.

	 Note the design series while selection of the 
valve!

The “File” menu provides the functions “Printer 
setup”, “Print preview” and “Print”. The print pre-
view includes the option for parameter set storage 
as text file (format.txt) prior to further processing. 
The “Options” menu provides also the selection 
of the RS232C interface port via the menu item 
“Port”. Via the menu item “Load file” previously 
stored parameter sets may be loaded.

Closer information can be can be displayed via 
the ProPxD parametrier software.

LED

Error code

Error code read-out under task menu “Diagnosis/
condition monitoring information” and “Diagnosis/
receive Error codes”
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P1 Adjustment of zero position displacement (offset).  
To compensate unbalances. 
Without 2nd control circuit (H21=0) for Pilot. With 2nd control circuit  
(H21 <> 0) for 2nd control circuit

P3 Adjustment of maximum signal span for positive output signal. 
To match the command signal span to the valve operating range.

P4 Adjustment of maximum signal span for negative output signal. 
To match the command signal span to the valve operating range.

P7 Adjustment of positive output signal step. 
To compensate for the valve overlap.

P8 Adjustment of negative output signal step. 
To compensate for the valve overlap.

P11 Adjustment of the command signal and diagnostic output signal 
polarity. 
To match the command signal polarity to the control system and 
downstream monitoring systems.

E17 Adjustment of the command signal input. 
To match the command signal input to the input signal mode.

E19 Adjustment of the operating mode for the command cable break 
detection. 
To turn on resp. off the cable break detection for the command signal  
at a selected command signal option of 4...20 mA.

Individual description of basic parameters

Parameter overview for basic mode

Adjustment parameters	

The available parameters may be divided into 
multiple groups and are characterized by different 
letters:	

P-parameters	 operating parameters
E, J, K-parameters	extended parameters
H-parameters	 supervising control parameters

Parameter Description Unit
Parameter Range  

ProPxD Default  
Setting

from up to
P1 Zero adjustment %  -90.0 90.0 0.0
P3 MAX channel A % 50.0 100.0 100.0
P4 MAX channel B % 50.0 100.0 100.0
P7 MIN channel A % 0.0 50.0 0.0
P8 MIN channel B % 0.0 50.0 0.0

P11 Input signal inversion –

0 = not inverted 
1 = CMD inverted  

2 = Diagnosis inverted  
3 = both inverted 

0

E17
Input signal (see installation 

instruction)
–

1 = ±10 V 1) 
2 = ±20 mA 1) 
3 = 4-20 mA 1) 

4 = 4-20 mA uni 2) 
5 = ±10 mA 1)

1

E19
Input signal cable break  

detection (only 4...20 mA)
–

out = 0 
on = 1

0

1) -100 %...+100 %
2)  0 %...+100 %
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Overview for additional expert mode parameter

Parameter Description Unit
Parameter Range  

ProPxD Default  
Setting

from up to
J8 Min supply voltage V 17 28 18
J9 Delay supply voltage ms 0 3000 1000

J12 Error handling –

0 = 	 no acknowledgment 
255 = 	 acknowledgment	
	 necessary 
768 = 	 no acknowledg-
ment 		  + diagnosis 
1023 = 	acknowledgment + 	
	 diagnosis

768

J16 4-20 mA diagnosis inversion –
0 = 	 not inverted  
1 = 	 Diagnosis 4-20 mA 	
	 inverted

0

K17 Pilot zero adjustment -20.000 20.000 0.000
H1 2nd control circuit P-amplification 0.00 100.00 0.00

H2
2nd control circuit 
P-part limitation

% 0.00 100.00 100.00

H17 2nd control circuit I-amplification 0.00 100.00 0.00
H18 2nd control circuit I-range 0.00 200.00 200.00
H19 2nd control circuit I-part limited % 0.00 100.00 100.00

H20
2nd control circuit zero adjust-

ment feedback 
-30.000 30.000 0.000

H21
2nd control circuit feedback 

selection
–

0 = 	 off 
1 =	 main stage ±10 V 1) 
2 = 	 main stage 1-10 V 2) 

3 =	 4-20 mA 1) 
5 =	 4-20 mA uni 2)

0

H22
2nd control circuit feedback 

multiplicator / polarity
% -300.00 300.00 100.00

H23
2nd control circuit feedback 

cable break detection
–

0 = 	 off 
1 = 	 on

0

H24
2nd control circuit 
driven / controlled 

–
0 = 	 driven 
1 = 	 controlled

0

H25
2nd control circuit D Input 

ring buffer
–

0 = 	 off  
2 = 	 2 x  
4 = 	 4 x  
8 = 	 8 x 

0

H26 2nd control circuit D-amplification -100.00 100.00 0.00
H27 2nd control circuit D -lead time 0.00 100.00 0.00
H28 2nd control circuit D-part limitation % 0.00 100.00 0.00

1) -100 %...+100 %
2)  0 %...+100 %
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J8
Adjustment of the minimal supply voltage below which the valve 
switches off with an error message.

J9
Adjustment of the minimum time the supply voltage should be above 
the set value of J8 for the valve to become ready for operation.

J12

Adjustment of error handling and report via diagnostic output:  
No acknowledgement necessary = fault will be deleted automatically 
as soon as the fault cause is solved (exception over current shotdown/
overload) 
Diagnosis => in fault case > +12.5 V voltage at the diagnosis output

J16
Polarity setting of the 4-20 mA diagnostic output. 
To match the downstream monitoring systems.

K17
Adjustment of zero position displacement (offset).  
To compensate unbalances.

H1
Adjustment of P-part for the controller. 
Basic configuration of the controller.

H2
Limitation of the P-part. 
To weighten the P-part in the correcting value.

H17
Adjustment of I-part for the controller. 
To reduce the control fault.

H18
Adjustment of the active range for the I-part regarding the control 
difference.  
To limit the I-part to a specific range.

H19
Limitation of the I-part. 
To weighten the I-part in the correcting value.

H20
Adjustment of the zero position displacement (offset).  
To compensate asymmetries in the sensor signal.

H21
Adjustment of the sensor-type. To match the feedback input to the 
sensor signal type

H22

Adjustment of feedback scaling and its polarity.  
To adapt the working range to the feedback-input range and the sen-
sor signal polarity of the control system. E.g. H23 = -120 % /  
H21 = 1 => +5 V Input gets converted to -6 V.

H23
Adjustment of the operating mode for feedback cable break detection. 
To activate or deactivate the cable break detection of the sensor signal.

H24
Adjustment of the operating mode of the controller.  
To select the contol function.

H25
Adjustment of the D input ring buffer depth. 
To smoothen the feedback signal before differentiation.

H26
Adjustment of D-part for the controller. 
To improve the control dynamics.

H27
Adjustement of the lead time for the DT1-element of the controller. 
To dampen of the D-part in the controller.

H28
Limitation of the D-part. 
To weighten the D-part in the correcting value.

Individual description of additional expert parameters
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Application: Closed loop systems for position 

Introduction

The electronics uses a feedback control loop which 
automatically adjusts the electrical input to the 
valve amplifier to move the drive to a commanded 
position. At the heart of this feedback loop is a 
digital controller which computes and updates the 
signal output (set value output) highly dynamic. The 
controller has adjustable coefficients, which must 
be set by the user for the particular application.
The controller provides a extended PID control 
capability plus extra features you can use to im-
prove the performance beyond the limits of PID. 

Basic information for the control algorithm 
Why tuning?

The controller can be used with valves that vary 
greatly in flow capacity, frequency response, 
saturation and deadband, with different kinds of 
load, and with cylinders of any area and stroke. 
The user must adjust the control coefficients for the 
specific system. There are no fixed sets of values 
for the controller coefficients that will handle every 
situation well.
The electronics utilizes a “PID” controller for its basic 
control action. The name PID comes from the fact 
that the controller output is the sum of three terms, 
called proportional (P), integral (I) and derivative (D), 
each with a user adjustable coefficient. 
The user software provides therefore the param-
eters H1 (P), H17 (I) and H26 (D).

P - H1
This term provides an immediate output signal, 
proportional to the error between commanded and 
measured position. If this parameter is set too high, 
sustained oscillations may occur. If it is set too low, 
accuracy and speed of response may be poor.
By using parameter H2 the setting of the variable 
is limited.

I - H17
This term causes the output to change at a rate 
proportional to the error in measured position over 
time (integration time), in a direction to drive the 
steady state error to zero. H17 is active within a 
window, which might be adjustable by parameter 
H18. H18 shall be adjusted in the way that the win-
dow lies near the final position or in the stationary 
range of the drive. A too higher value of H17 causes 
oscillations, in addition to which the selection of a 
too lower value may result in a slow action.
By using parameter H19 the setting of the variable 
can be limited.

D - H26
The D-term provides an output proportional to 
the rate of change of the measured drive position. 
Depending on the polarity of the parameter prefix, 
this term causes damping or acceleration. For hy-
draulic drives this term should be set to a low value.
By using parameter H27 lead time the rise can 
be damped.
By using parameter H28 the setting of the variable 
can be limited.

Simple tuning of a position control loop

Before trying anything complicated, you should 
adjust the proportional gain, accessible by H1. In 
many cases this coefficient will be all you need, 
and you will not have to bother with any of the 
other control features. If you do need the other 
features, you cannot adjust them properly without 
first adjusting the P-gain. Adjusting the P-gain is 
done by setting all the other control coefficients 
H2-H21 as well as H23-H28 to zero and increas-
ing H1 to the highest value that does not result in 
sustained oscillations of the drive position.
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Guarantee of control functionality

Before the tuning of the control loop may be com-
menced, the functionality of the control circuit must 
be ensured. As previously mentioned, the control-
ler compares command and feedback signal and 
adjusts the electrical input to the valve amplifier 
to move the drive to the commanded position. To 
ensure this functionality, the polarities of command 
and feedback signal must be equal. 

How can the functionality of the control loop 
be achieved?

At first you should set off the control loop (set pa-
rameter H24 to value 0 = open loop and transmit 
to the electronic) and cause the drive via manual 
control to the middle of the cylinder stroke. Af-
terwards adjust at first the control coefficients as 
described in chapter “Simple tuning of a position 
control loop” (H1 at 10 %) as well as the parameter 
H24 at 2 = external closed loop and transmit to the 
electronic. If this results in a rapid movement of the 
drive to an end position, the polarities are incorrect. 
Access now the parameter H22 = feedback signal 
polarity, change the value and transmit the data. 
The drive should be adjustable and remain in its 
position when you switch on the closed loop control 
via parameter H24. Now you should preset position 
commands and supervise the drive movement. 
If the drive even tough is running in closed loop 
mode, but the direction of the movement is not as 
required, you have to change the polarities of both 
command and feedback signal via the parameters 
P11 and H22. After that the drive is running as 
desired, you can continue with tuning of the loop.

Tuning of the closed loop control

1.	Create a suitable tuning test profile – otherwise 
it may be difficult for you to tell how good the 
system response is. The test profile should 
programmed in a way to cause the drive to 
move from the start position to the required 
final position with the desired maximum ac-
celeration and velocity. In the final position the 
drive should be commanded to dwell, that will 
give you enough time to watch the load position 
to see if it oscillates or remains stationary. This 
should be followed by returning the drive to the 
start position, where the dwell in position may 
also be evaluated.

2.	Check once more to be sure that H17 and H26 
are set to zero.

3.	Adjust H1 to a low value, i.e. 10 %, and try the 
system on the test profile. Observe the result 
of the test. There are three possible outcomes:

•	 The drive oscillates continuously 
Stop the system quickly. Reduce the H1-value 
to ½ of the initial guess, and try again.

•	 The drive overshoots, but stops after one or 
two oscillations. 
Reduce the H1-value to ¾ of the initial guess, 
and try again.

•	 The drive reaches the commanded position with 
no overshoot.
The system is usable with the estimated value 
of P-gain. You should experiment by increasing 
the H1-value stepwise to see how high a value 
the system will tolerate. Accuracy and response 
are improved by high values, but do not allow 
permanent oscillation!
You have now completed the basic tuning for 
your control loop. The next step is to test the 
performance of the system to whether it meets 
your requirements. If not, the electronic has ad-
ditional control features you can use to improve 
performance, as explained below.
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Problem Solution 

Positon error too large, when drive is 
stationary

Use parameter P17 – I-gain increase 
(only if P26 = 10 %)

Disappointingly low P-gain Check the frequency response of the valve and positon 
transducer, or possibly the drive resonant frequency  
(s. item below)

Response too slow Be sure H1 = P-gain is adjusted high enough  
(s. also previous items)

Unexplainable problems Check the setting of all parameters

Improving system performance
Using the parameter H17 = I-gain

The integrator gain (abbreviated I) can be adjusted 
to reduce or eliminate the error between the com-
manded position and the position measured by 
the feedback transducer, subject to the com-
mand remaining constant. Higher values of I-gain 
will cause the response to be slower and more 
prone to oscillation with the combined effect of a 
reduced stationary error. Lower values will require a 
reduced time to reach zero steady state error. This 
parameter is only active if a window (5 – 20 %) is 
defined via H18.

Elimination of slow, small amplitude oscillation 
in position

Because of friction and other imperfections, use of 
the I-gain sometimes causes a slow, small ampli-
tude oscillation in load position. This is an entirely 
different problem from the vigorous oscillations that 
occur when the P-gain is set too high. The elec-
tronics provides a “Window” feature (sometimes 
called “in-position-window”) to solve this problem. 
Select the parameter H18. Stepwise increasing of 
the window size to a large enough value will stop 
the slow oscillations.

Increasing load stiffness

“Load stiffness” is the term given to the resistance 
of the servo loop to deflection of the drive by ex-
ternal forces. Adjusting P-gain (H1) to the highest 
practical value is important. 

Disappointing control loop function

The higher the value of P-gain is adjusted, the 
better is the static and dynamic performance of 
the system. You may not have any direct need for 
fast response, but may still need a high value of 
P to reduce static error, reduce following error or 
increase load stiffness. High values of P cause faster 
system response, whether you need it or not. As 
the system frequency response gets too close to 
the frequency response of one of your components, 
the system response becomes oscillatory.

•	 Valve
	 The frequency response of the valve can be ob-

tained from catalogue HY11-3500/UK “Hydraulic 
Valves Industrial Standard“ series D1FP/D3FP. 
As a first guess, it needs to be at least twice the 
system frequency response.

•	 Position transducer
 	 Some analog output transducers will present 

problems because of filtering intended to smooth 
the output. To ensure the best system dynamic, 
sensors with integrated D/A-converter should 
operate with a high sampling rate. Magnetostric-
tive transducers with digital output often have a 
low sampling rate, because of an interaction with 
the achievable resolution. Please obtain detailed 
information from the transducer supplier.

•	 Drive
 	 There is a mode of mechanical vibration created 

by the mass of the load and the compressibility of 
the hydraulic fluid in the whole system (cylinders, 
pipe, valve). This frequency is often surprisingly 
low when using long stroke cylinders.

The table below gives information which approaches may be embarked if typical problems with posi-
tion control loops appear.
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Sampling rate of the controller

The controller updates the electrical output to the 
valve at >1 kHz. This rate is fast enough to have 
negligible effect in almost all hydraulic applications, 
but it does set an absolute limit on the response 
of the system. 

Position transducer accuracy and resolution

A control system cannot be better than its trans-
ducer. 
Here are points to watch for:

•	 Absolute accuracy 
	 The controller positions the load as closely 

as possible to the position measured by the 
feedback transducer. The absolute accuracy 
of the measured position is determined by the 
transducer.

•	 Resolution
	 The electronics cannot position the load more 

accurately than the resolution of the transducer. 
Be sure the resolution of your sensor is adequate. 
When using a true analog transducer (analog 
measurement principle and analog output), the 
resolution is limited by the utilized A/D-converter, 
which is 16 bit (1/4096 = 0.025 %).

•	 Installation
	 The installation of the position transducer plays 

a most important rule for the proper functionality 
of the closed loop control. By all means it has 
to be secured, that the mounting of transducer 
and actuating device provides absolute freedom 
from vibration and clearance effects. This is most 
important even for the commonly expected ve-
locities and accelerations. Also, the transducer 
has to be laid out for the dynamic requirements.
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Failure message Description/corrective action
The Com Port is not available! Terminate the other program, or quit the message and select 

another RS232C port via the menu “Options > Port”. Afterwards 
reconnect the parametrizing cable.

Unable to open COM port Com port is not available. Quit the message and select another 
RS232C port via the menu “Options > Port”. Afterwards reconnect 
the parametrizing cable.

There is no module/valve 
connected or the communi-
cation is disturbed! Please 
check also the interface!

No data exchange possible. Either the electronic has been re-
moved, the port is mismatched, or the connection will be dis-
turbed by strong electrical fields. Check if the Com port is set for 
“115200, 8, 1. none, none” via the menu “Options > Port”.

Wrong password Retype the password, notice the exact spelling (case sensitivity).
Wrong input An unvalid character or a value outside the permitted range has 

been used at parameter entry.
The chosen module/valve 
isn´t the same as the con-
nected hardware. Attention! 
Unsaved parameters will be 
lost.

In principle, parameters dedicated to a type which deviates from 
the connected valve may be edited. However, for data transmit-
ting the correct valve has to be connected. If parameters will be 
loaded from a valve which deviates from the selected one, the 
parameters from the left hand side screen display of the program 
will be overwritten.

The chosen hardware isn´t the 
same as the connected mod-
ule/valve.

The wrong valve type has been selected from the database, after-
wards the function “send all” has been executed.

Attention! Factory settings 
will be changed! Transmit 
anyhow?

Default parameters has been read out from the database instead 
from the valve via the function “receive all”.

file name.pxd already exists. 
Do you want to replace the 
file?

The file name already exists within the indicated directory. Select 
another name, another directory or overwrite the existing file with 
“OK”.

Further message Description
Keep the entered param-
eters?

During parameter loading from the electronics memory the preset 
parameters from the left hand screen display may be rejected or 
maintained.

Error messages

Malfunctions when using the ProPxD software program will be indicated via appropriate failure messages.

Failure messages and corrective actions:

Flushing				  

It is recommended to flush the pipelines by short 
circuiting the pressure and return lines. This pre-
vents the installation dirt from entering the valve.

Air bleeding of hydraulic system	

During initial startup, after an oil change as well as 
after the opening of lines or valves the hydraulic 
system must be air bleeded.

Filter

The function and lifetime of the valve are strongly 
affected by the cleanliness of the fluid.
Purity level class of 18/16/13 acc. ISO4406 is 
required.	



24

Prop. Directional Control Valve
Series DFplusOperation Manual

Parker Hannifin Corporation

D_FP_D 5715-695 UK.indd 16.09.21

6.	 Trouble shooting

Basis of troubleshooting is always a systematic 
approach.

	For suspect of a sluggish spool the valve 
may be flushed with clean pressure fluid.

	Troubleshooting in a hydraulic system re-
quires detailed knowledge about function 
and construction of the system. Therefore 
the work may exclusively be performed by 
qualified personnel.

malfunction at hydraulic load runtime
- generally no function

- high frequent oscillation
- low frequent oscillation

- one way operation only
- speed variations at unchanging command

- different speeds depending on travel direction
- speed too low

- drifting without command
- poor dynamic
possible reasons for malfunction corrective actions

X hydraulic pump resp. motor defective replace hydraulic pump resp. motor
X X X X X X X drive overloaded reduce pressure resp. speed, increase valve size
X X X X X X X X valve contaminated clean pressure fluid, filter / flush valve

X X X hydraulic fluid too viscous / too cold change fluid grade, provide operational temperature
X X X too low oil level within tank refill pressure fluid

X X X filter contaminated replace filter
X X X X supply voltage too low keep supply voltage range

X supply voltage carries too much ripple reduce ripple
X X X command signal too low increase command signal

X command signal carries too much ripple reduce ripple
X X center position adjustment incorrect check center position adjustment

X X X X X contacts of central connector contaminated clean contacts / replace plug
X feed cable interrupted fix feed cable
X X X X X X X wiring sequence incorrect correct wiring sequence

X X feed cable without shielding change cable grade
X pilot pressure too low or failed increase pilot pressure to min. 20 bar

X X X pilot pressure too low increase pilot pressure to min. 20 bar
X pilot pressure too low increase pilot pressure to min. 50 bar

7.	 Accessories / Spare parts

Accessories

The following accessories are available for the 
valve series DFplus:

Bolt kit

D1FP 	 ordering code BK 375
D3FP	 ordering code BK 385

Female connection

Code 0: 6+PE	 ordering code 5004072
Code 5: 11-PE	 ordering code 5004711
Code 7: 6-PE	 ordering code 5004072

Spare Parts

Seal kit NBR

D1FP  	 ordering code SK-D1FP
D3FP 	 ordering code SK-D3FP
Seal kit FPM

D1FP 	 ordering code SK-D1FP-V
D3FP 	 ordering code SK-D3FP-V

Seal kit HFC

D1FP 	 ordering code SK-D1FP-H
D3FP 	 ordering code SK-D3FP-H
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